Application example • 11/2015

Calculation and Design of Fieldbus Segments in the PCS 7 environment using the SIMATIC Fieldbus Calculator

SIMATIC PCS 7

Warranty and liability

Note

The Application Examples are not binding and do not claim to be complete regarding the circuits shown, equipping and any eventualty. The Application Examples do not represent customer-specific solutions. They are only intended to provide support for typical applications. You are responsible for ensuring that the described products are used correctly. These application examples do not relieve you of the responsibility to use safe practices in application, installation, operation and maintenance. When using these Application Examples, you recognize that we cannot be made liable for any damage/claims beyond the liability clause described. We reserve the right to make changes to these Application Examples at any time without prior notice.

If there are any deviations between the recommendations provided in these Application Examples and other Siemens publications – e.g. Catalogs – the contents of the other documents have priority.

We do not accept any liability for the information contained in this document.

Any claims against us – based on whatever legal reason – resulting from the use of the examples, information, programs, engineering and performance data etc., described in this Application Example shall be excluded. Such an exclusion shall not apply in the case of mandatory liability, e.g. under the German Product Liability Act ("Produkthaftungsgesetz"), in case of intent, gross negligence, or injury of life, body or health, guarantee for the quality of a product, fraudulent concealment of a deficiency or breach of a condition which goes to the root of the contract ("wesentliche Vertragspflichten"). The damages for a breach of a substantial contractual obligation are, however, limited to the foreseeable damage, typical for the type of contract, except in the event of intent or gross negligence or injury to life, body or health. The above provisions do not imply a change of the burden of proof to your detriment.

Any form of duplication or distribution of these Application Examples or excerpts hereof is prohibited without the expressed consent of the Siemens AG.

Security information

Siemens provides products and solutions with industrial security functions that support the secure operation of plants, solutions, machines, equipment and/or networks. They are important components in a holistic industrial security concept. With this in mind, Siemens' products and solutions undergo continuous development. Siemens recommends strongly that you regularly check for product updates.

For the secure operation of Siemens products and solutions, it is necessary to take suitable preventive action (e.g. cell protection concept) and integrate each component into a holistic, state-of-the-art industrial security concept. Third-party products that may be in use should also be considered. For more information about industrial security, visit [http://www.siemens.com/industrialsecurity](http://www.siemens.com/industrialsecurity).

To stay informed about product updates as they occur, sign up for a product-specific newsletter. For more information, visit [http://support.industry.siemens.com](http://support.industry.siemens.com).
Preface

Objective of this document
This document is aimed at explaining the function principle and operation of the application SIMATIC Fieldbus Calculator by some examples.

Core topics
This application description covers the following main points:
- User interface of the SIMATIC Fieldbus Calculator
- Layout and calculation of PROFIBUS PA and FOUNDATION Fieldbus H1 fieldbus segments with the SIMATIC Fieldbus Calculator

Validity of application
The SIMATIC Fieldbus Calculator is used for the calculation of PROFIBUS PA and FOUNDATION Fieldbus H1 field segments which are fed from a fieldbus coupler
The following coupler / bundles are supported:
- DP/PA coupler (6ES7157-0AC83-0XA0)
- Field Device Coupler FDC 157 (6ES7157-0AC84-0XA0)
- Field Device Coupler FDC 157 (6ES7157-0AC85-0XA0)
- Compact FF link (6ES7655-5BA00-0AB0)

The structure is based on
- AFD (Active Field Distributor)
- AFDiS (Active Field Distributor intrinsic Safety)
- AFDiSD (Active Field Distributor intrinsic Safety Diagnostic)
# Table of contents

Warranty and liability ........................................................................................................... 2
Preface .................................................................................................................................. 3
1 Task Description .............................................................................................................. 5
1.1 Introduction .................................................................................................................. 5
1.2 Description ................................................................................................................... 5
2 Solution .............................................................................................................................. 6
2.1 Overview of the general solution .................................................................................. 6
2.2 Core functionality ......................................................................................................... 7
2.3 Application components ............................................................................................... 8
3 Basics ............................................................................................................................... 9
3.1 Components of the SIMATIC Fieldbus Calculator ...................................................... 9
3.2 Fieldbus ....................................................................................................................... 14
3.3 Quantity framework, line length, current and voltage ................................................ 15
4 Function mechanisms ...................................................................................................... 18
5 Installation and Startup ................................................................................................. 22
6 Operation of the application ........................................................................................... 23
6.1 Scenario A – configuration with PROFIBUS PA ......................................................... 23
6.2 Scenario B – configuration with FOUNDATION Fieldbus ....................................... 28
7 Further notes, tips and tricks, etc. .................................................................................. 31
8 Related literature & links ............................................................................................... 32
8.1 Literature ..................................................................................................................... 32
8.2 Internet links ................................................................................................................ 32
9 History .............................................................................................................................. 33
1 Task Description

1.1 Introduction

SIMATIC PCS 7 is based on a consistent architecture. This architecture enables the integration of devices using different types of communication. In the area of process automation, the following types of field device communication are commonly used:

- conventional 4 – 20 mA (optionally with HART protocol)
- PROFIBUS DP
- PROFIBUS PA
- FOUNDATION Fieldbus H1

The successful planning of fieldbus segments requires to find an optimum combination with regard to the area of application, quantity framework and topology. Furthermore, the physical and system-specific requirements and restrictions (number of devices, length of lines, topology) must be taken into account.

1.2 Description

The figure below provides an overview of the automation task.

Figure 1-1

Fieldbus segment

PROFIBUS specification
Total length of segment = 1 900 m (FISCO)
Min. voltage= 16 V
Cable resistance = 44 Ω/km

Calculations
Segment length
800 m + 300 m + 200 m + 80 m + 80 m + 80 m + 80 m = 1620 m

Currents
25 mA + 10 mA + 12 mA + 10 mA + 12 mA + 25 mA = 94 mA

The users shall be provided with a tool that assists them in the planning and laying out of fieldbus segments. In doing so, the physical requirements for a fieldbus segment have to be checked and evaluated.

These include:
- voltages and currents during normal operation
- voltages and currents during the start-up of a segment (when activated)
- lengths of lines
- number of devices
2 Solution

2.1 Overview of the general solution

Schematic layout

The following illustration provides a schematic overview of the most important components of the solution.

Figure 2-1

![Diagram showing plant configuration and SIMATIC Fieldbus Calculator for segment calculation]

The relevant physical information (line lengths, basic current of the devices, topology, etc.) for each fieldbus segment are entered. Based on this data and the defined configuration, the SIMATIC Fieldbus Calculator then calculates the relevant physical and electrical values.

Topics not covered by this application

The SIMATIC Fieldbus Calculator is used for the calculation of PROFIBUS PA and FOUNDATION Fieldbus H1 fieldbus segments.

For this reason, PROFIBUS DP will not be considered in this application.

Furthermore, this document does not include a description of the layout and configuration of fieldbus segments.

Assumed knowledge

Basic knowledge of the fieldbus types PROFIBUS PA and FOUNDATION Fieldbus H1 (communication, technology, structure and function principle) is assumed.
2.2 Core functionality

The user interface is divided into an input area and a calculation area.

Figure 2-2

Input area

The input area (white background) is used to enter the relevant parameters and line lengths of the segment.

To enable reasonable calculation, the input values must comply with the local structure or the later structure (planning).

Calculation area

The calculation area displays the values calculated for the segments and the parameter values of the active field distributors. It also provides the user with further information about the segments and parameter values.

On the basis of these values, the user can adapt, expand and optimize the individual fieldbus segments.

Furthermore, it is a helpful tool for fault detection and localization, if the quantity framework is exceeded.

Advantages of this solution

The solution presented in this document offers the following advantages:

- Free use of the tool
- Flexible planning of the fieldbus segments through the modification of line lengths and shifting of field devices.
- Information if the individual electrical values exceed the defined limits.
- The existing configurations can be checked and expanded, if required.
2.3 **Application components**

The following list shows all files and projects used in this example.

Table 2-1

<table>
<thead>
<tr>
<th>Component</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>53842953_SIMATIC_Fieldbus_Calculator.zip</td>
<td>Tool for the calculation of fieldbus segments</td>
</tr>
<tr>
<td>53842953_SIMATIC_Fieldbus_Calculator_DOCU_en.pdf</td>
<td>This document</td>
</tr>
</tbody>
</table>
3 Basics

3.1 Components of the SIMATIC Fieldbus Calculator

PA link

The PA link enables network transition from a PROFIBUS PA fieldbus to a higher-level communication system (e.g. PROFIBUS DP) at the recommended transmission rates (with PROFIBUS DP up to 12 Mbit/sec, with PROFIBUS PA up to 31.25 Kbit/sec).

The combination of the PA link with a fieldbus coupler, e.g. the FDC 157, allows for the following configuration variants:

- line architecture
- line architecture with coupler redundancy
- line and ring architecture with coupler and media redundancy

Technical data:
- Max. 5 FDC 157 in line architecture (five PA trunks)
- 5 FDC 157 in line architecture with coupler redundancy (four PA trunks)
- 3 FDC 157 in line architecture and 2 FDC 157 in ring architecture with coupler redundancy
- Max. 31 devices per trunk
- Max. 64 devices per segment
- Max. length of 1 900 m per trunk

Further features of the PA link:

- The use of bus modules as backplane bus enables “plug & pull” during active operation.
- Setup of a PA link redundancy.
NOTE

The typical quantity framework for PROFIBUS PA applications lies between 16 and 18 field devices per trunk. This quantity framework enables a reaction time of approx. 10 msec per field device.

**FF link**

The FF link enables network transition from a FOUNDATION fieldbus H1 to a higher-level communication system (e.g. PROFIBUS DP) at the recommended transmission rates (with PROFIBUS DP up to 12 Mbit/sec, with FOUNDATION Fieldbus H1 up to 31.25 Kbit/sec).

The combination of the FF link with the FDC 157 allows for the following configuration variants:

- line architecture
- line architecture with coupler redundancy
- ring architecture with coupler and media redundancy

Figure 3-2

Further features of the FF link:

- The use of bus modules as backplane bus enables “plug & pull” during active operation.
- “Control in the field” support
NOTE
The quantity framework for applications with FOUNDATION Fieldbus H1 typically includes 9 field devices.
This quantity configuration enables an acceptable reaction time of the field devices connected to the fieldbus.

FDC 157
The FDC 157 ("Field Device Coupler") serves as a physical link between a fieldbus segment/trunk (PROFIBUS PA or FOUNDATION Fieldbus H1) and a higher-level communication system (e.g. PROFIBUS DP).
The main task of the FDC 157 is to supply the bus with power (30 V/1 000 mA) for the subordinate fieldbus segment/trunk, i.e. to feed the connected field devices with the current and voltage levels they require for operation.
Further features of the FDC 157:
- a redundant structure is possible
- potential isolation between the subordinate fieldbus segment and the higher-level communication system
- diagnostic functions
- integrated bus terminator
- transmission rate of 31.25 Kbit/sec
- suitable for line, tree and ring topology

Compact FF link
The Compact FF Links unite Link and coupler functionality into a single compact module component.
The Compact FF link enables network transition from a FOUNDATION fieldbus H1 to a higher-level communication system (e.g. PROFIBUS DP) at the recommended transmission rates (with PROFIBUS DP up to 12 Mbit/sec, with FOUNDATION Fieldbus H1 up to 31.25 Kbit/sec).

NOTE
Only the Compact FF Link is configured in HW Config. The configuration of a Field Device Coupler (FDC) is not necessary.

Figure 3-3

<table>
<thead>
<tr>
<th>Technical data</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Line architecture</td>
</tr>
<tr>
<td>• Max. 31 devices per trunk / segment</td>
</tr>
<tr>
<td>• As an LAS (Link Active Scheduler) the FF Link is suitable for distributed communication control (Control in the Field).</td>
</tr>
<tr>
<td>• Max. segment length of 1 900 m</td>
</tr>
</tbody>
</table>
Table 3-1: Comparison of Compact FF Link with FF Link

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Compact FF Link</th>
<th>FF Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output current</td>
<td>500 mA</td>
<td>1 A via FDC</td>
</tr>
<tr>
<td>Redundant operation (H CPU)</td>
<td>Two Compact FF Links + bus module (6ES7655-5EF00-0AA0)</td>
<td>Two FF Links + bus module BM IM/IM (6ES7195-7HD80-0XA0)</td>
</tr>
<tr>
<td>Coupler redundancy / ring redundancy</td>
<td>Only in redundancy mode</td>
<td>Independent of redundancy operation using two FDCs</td>
</tr>
</tbody>
</table>

**NOTE**
A redundant installation with two Compact FF Links is realized with the bus module for redundant operation (6ES7655-5EF00-0AA0). You can find additional information on redundant operation with coupler or ring redundancy in the operating instructions “SIMATIC Bus link Compact FF Link”.

**AFS**

The “Active Field Splitter” (AFS) combines a pair of couplers (two FDC 157 or two Compact FF link units) with a PA or FF H1 trunk. In the event of a fault (failure of the active FDC 157 or line fault between AFS and FDC 157), the system will automatically switch over to the standby coupler.

**AFD**

The “Active Field Distributor” (AFD) is used for the connection of field devices (sensors and actuators) in operating environments according to Ex-Zone 2/22. In combination with two FDCs 157 units or two Compact FF Links, redundant operation (ring or coupler redundancy) can be configured. One fieldbus segment may include a maximum of 8 AFDs (if combined with AFDiS / AFDiSD, max. 5 field distributors).

Further features of the AFD:
- short-circuit-protected spur line connections
- automatic bus termination
- protection type IP65
- visual display (status of / fault in main line and spur lines)
- max. 4 (AFD4) or 8 (AFD8) devices / spur lines per AFD

**AFDiS**

The “Active Field Distributor intrinsic Safety” (AFDiS) can be used in operating environments according to Ex-Zone 1/21 and 2/22. Due to its intrinsically safe and short-circuit-resistant spur line connections it enables the integration of intrinsically safe PA (PROFIBUS PA) or FF H1- (FOUNDATION Fieldbus H1) field devices in a fieldbus segment (line/ring). Instead of a spur line, up to 4 devices of max. 500 meters in length can be connected to a subsegment. The spur line and the subsegment (S1 connector) correspond to the ignition protection type Ex [ia] and are admissible for use up to zone 0/20.

Further features of the AFDiS:
- short-circuit-proof spur line connections
- automatic bus termination
3 Basics

- protection type IP66
- max. 5 AFDiS, also in combination with AFD
- visual display (status/fault in the main line, the spur lines and the subsegment)
- max. 6 devices/spur lines per AFDiS or 5 devices/spur lines and a subsegment with max. 4 devices

**NOTE**
The number of devices at the subsegment (connector S1) is limited to the available direct current of max. 60 mA.

**AFDiSD**
The AFDiSD is the further development of the AFDiS and offers the same technical properties in addition to diagnostics functionality (configuration via mode selector: "D" = Extended Fieldbus Diagnostics).

**NOTE**
The AFDiSD replaces the predecessor AFDiS if a spare part is necessary. During operation, the mode selector of the AFDiSD is set to compatibility mode (switch setting = "C").
Please refer to the product information "SIMATIC Bus links Amendments to the operating instructions for DP/PA coupler, active field distributors, DP/PA Link... 07/2011" for more information.

**Combined use of AFD and AFDiS / AFDiSD**
A combination of AFD and AFDiS / AFDiSD allows the use of max. 5 field distributors in one fieldbus segment/trunk.
3.2 Fieldbus

The fieldbus is based on the digital communication of field devices (sensors and actuators) with a higher-level system, e.g., a SIMATIC S7-400 controller. This is realized by using a common communication basis where the field devices (with a standardized protocol) are connected via a joint medium (line). Apart from the reduced wiring efforts, the fieldbuses provide maintenance and diagnostic information about the field devices.

In the area of process automation, the connection and supply of sensors and actuators is usually realized with the fieldbus types PROFIBUS PA and FOUNDATION Fieldbus H1.

**NOTE** Apart from the above-stated fieldbuses PROFIBUS PA and FOUNDATION Fieldbus H1, there is a number of other fieldbuses available on the market, such as PROFIBUS DP and PROFINET which, however, are not discussed in this application description.

**PROFIBUS PA**

The PROFIBUS PA is optimized for process-based industries and enables the installation of field devices up to the Ex-areas. The transmission technology MBP (Manchester Coded, Bus Powered) enables digital data transmission and energy supply via one single line. Usually, the field devices have a response time of 10 ms.

Network transition from the PROFIBUS PA to the higher-level system bus PROFIBUS DP is realized by means of a PA link. The combination of PROFIBUS DP and PROFIBUS PA enables the configuration of a safety communication system based on the PROFIsafe profile.

**FOUNDATION Fieldbus H1**

Like the PROFIBUS PA, the FOUNDATION Fieldbus H1 is also designed for use in process-based industries. Both types of fieldbuses are based on the same MBP transmission technology and communicate with the same transmission rate of 31.25 Kbit/sec. An FF H1 segment enables the realization of small control circuits independently of the automation system.

Network transition from the FOUNDATION Fieldbus H1 to the PROFIBUS DP is realized by means of an FF link or Compact FF link.
3.3 Quantity framework, line length, current and voltage

Fieldbus

Quantity framework and line lengths
The total length of a PROFIBUS PA trunk and a FOUNDATION Fieldbus H1-segment is limited to max. 1900 meters. With the help of a repeater, however, the maximum line length can be extended.

Depending on the specific hardware components, the configuration and the data volume, the following quantity frameworks can be realized:

- PROFIBUS PA
  - max. 64 devices within one segment (max. 5 segments without coupler redundancy and 4 segments with coupler redundancy)
  - max. 31 devices per trunk

- FOUNDATION Fieldbus H1
  - max. 32 devices within the segment (FDC 157 + max. 31 field devices at the trunk)

NOTE
The number of devices within one segment depends on the data volume to be transmitted. With PROFIBUS DP, the max. message frame length (configuration data, parameter data, diagnosis data and I/O data) per DP slave (PA link / FF link) is 244 bytes. Depending on the parameter settings, a minimum of 5 bytes of user data (4 bytes measured value + 1 byte status) will be transmitted for each field device at cyclic intervals.

Current and voltage
The currents and voltages for the energy supply of a segment/trunk are defined as follows:

- FDC 157 for applications which are not intrinsically safe
- FDC 157: 1 000 mA output current
- Compact FF link: 500 mA output current
- 30 V to 32 V DC

NOTE
The SIMATIC fieldbus calculator considers a voltage drop which is calculated on the basis of the defined line lengths, the cable type used and the power loss (internal requirements) of the active field distributors AFD and AFDiS / AFDiSD. The calculation tool is based on cable type A with a specified cable resistance of 44 Ω/km (menu command “Edit > Settings”).

The current for the supply of a fieldbus trunk is composed as follows:

- ≥ 10 mA per field device (depending on the specific device)
- ± 9 mA for communication (MBP transmission technology)
- ≤ 9 mA fault current (FDE = Fault Disconnection Electronic)
NOTE

The total current available is calculated on the basis of the amount of current required by all electric consumers (field devices and active field distributors). The max. output current of the feeding device must not be exceeded.

AFD

Quantity framework and line lengths
When using the active field distributor AFD, the lengths of the spur lines (not intrinsically safe) must be considered for calculation of the total length.

Table 3-2

<table>
<thead>
<tr>
<th>Number of spur lines (1 device per spur line)</th>
<th>Length of one spur line</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 to 12</td>
<td>120 m</td>
</tr>
<tr>
<td>13 to 14</td>
<td>90 m</td>
</tr>
<tr>
<td>15 to 18</td>
<td>60 m</td>
</tr>
<tr>
<td>19 to 24</td>
<td>30 m</td>
</tr>
<tr>
<td>25 to 31</td>
<td>1 m</td>
</tr>
</tbody>
</table>

Current and voltage
Operation of the active field distributor AFD requires a supply voltage (DC) between 16 V and 32 V.
The current consumption of the AFD is calculated as follows:
- Internal requirement of 25 mA + aggregate current of all field devices (max. 4 x 60 mA)
- Internal requirement of 59 mA (AFD at the line end as active bus terminator) + aggregate current of all field devices (max. 4 x 60 mA)

AFDiS / AFDiSD

Quantity framework and line lengths
In contrast to the AFD, calculation of the total length of the spur lines and the subsegment of the AFDiS need not be considered.

Table 3-3

<table>
<thead>
<tr>
<th>Intrinsic safety</th>
<th>Number of spur lines (1 device per spur line)</th>
<th>Length of one spur line</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not intrinsically safe</td>
<td>1 to 31</td>
<td>120 m</td>
</tr>
<tr>
<td>Intrinsically safe according to FISCO</td>
<td>1 to 31</td>
<td>60 m</td>
</tr>
</tbody>
</table>

The connector S1 at the AFDiS / AFDiSD enables the use of a subsegment up to EX-zone 0/20 with the following quantity configurations:
- subsegment of max. 500 m in length
- max. 4 devices (current of max. 60 mA for the subsegment)
NOTE

If a subsegment at connector S1 is configured, a bus terminator must be available after the last field device. The bus terminator consists of a 100 Ω resistor and a 1 µF capacitor connected in series.

Current and voltage

The active field distributors AFD and AFDiS / AFDiSD require a supply voltage between 16 V and 32 V. Compared to the active field distributor AFD, the current consumption of the active field distributor AFDis / AFDiSD changes according to the available voltage.

Current consumption is calculated as follows:

- at an input voltage of 28 V: 64 mA + (0.838 x aggregate current of all field devices)
- at an input voltage of 24 V: 67 mA + (1.008 x aggregate current of all field devices)
- at an input voltage of 20 V: 74 mA + (1.246 x aggregate current of all field devices)
4 Function mechanisms

General overview

Figure 4-1

SIMATIC Fieldbus Calculator for segment/trunk calculation

Based on the user configuration and the entered data, the SIMATIC Fieldbus Calculator calculates the data for the specific segment or trunk. The red background color of a row signals violation or disregard of the limits relevant for operation. These limits are defined on the basis of the fieldbus standard and the system properties of the components used.

NOTE
Please note that a valid calculation can be performed only after the “Calculate” button has been pressed.

1. Menu bar
   You can create, save or load a configuration in the "File" menu. In addition you can export a configuration as a picture.
   You can set the cable resistance and the programming interface language (restart required) in the "Edit" menu.

2. Total segment length

3. Electrical values (currents and voltages) of the segment/trunk
   This area ("Segment Calculation") provides the user the following information:
   - “Required Current (L \(\rightarrow\) R)”: The total current requirement in line or ring architecture, if fed by the left coupler. The required current comprises the internal requirements of the active field distributors and the connected field devices.
   - “Required Current (R \(\rightarrow\) L)”: Same as “Required Current (L\rightarrow R)” for ring architecture, if fed by the right coupler.
4 Function mechanisms

- "Minimal AFD Input Voltage (L → R)"
  The voltage available at the first active field distributor of the fieldbus in line and ring architecture. The voltage is reduced by the line length and the associated voltage drop between the feeding coupler (left side) and the active field distributor.

- "Minimal AFD Input Voltage (R → L)"
  The voltage available at the first active field distributor of the fieldbus in ring architecture. The voltage is reduced by the line length and the associated voltage drop between the feeding coupler (right side) and the subsequent active field distributor.

- "Startup Surge Current (L → R)"
  Current required during start-up of the segment/trunk, if fed by the left coupler.

- "Startup Surge Current (R → L)"
  Current required during start-up of the segment/trunk in ring architecture, if fed by the right coupler.

- "Startup Min. Voltage (L → R)"
  Voltage required during start-up of the segment/trunk, if fed by the left coupler.

- "Startup Min. Voltage (R → L)"
  Voltage required during start-up of the segment/trunk in ring architecture, if fed by the right coupler.

- "Capacitor Charge Current (L → R)"
  Excessive current caused by the connection of spur 6 (AFDiS / AFDiSD), if fed by the left coupler.

- "Capacitor Charge Current (R → L)"
  Excessive current caused by the connection of spur 6 (AFDiS / AFDiSD) in ring architecture, if fed by the right coupler.

- "Capacitor Charge Min. Voltage (L → R)"
  Minimum voltage when connecting spur 6 (AFDiS / AFDiSD), if fed by the left coupler.

- "Capacitor Charge Min. Voltage (R → L)"
  Minimum voltage when connecting spur 6 (AFDiS / AFDiSD) in ring architecture, if fed by the right coupler.

- "Coupler Switch Current"
  Short-term peak current which occurs during coupler switchover in ring architecture.

- "Loop Stability Check"
  Identification of a corrected fault (e.g. cable break) at the segment/trunk in ring architecture.

- "Calculate" button
  Used to calculate the electrical values of the segment/trunk and to evaluate the calculated values.

4. Line lengths and structure of the segment/trunk

This area is used to define the segment/trunk structure (FDC 157 or Compact FF link, ring architecture, FISCO, selection of active field distributors). Furthermore, the line lengths between the individual components of the main line are entered here. The line lengths are required to calculate the total length (main line and spur lines). The selection of an active field distributor affects the input fields stated in point 6 "Consumers on the spur lines" and point 7 "Spur line lengths".
5. Quantity framework and electrical values at the active field distributor

This area provides the user the following information:

- **“L → R Voltage”**
  Voltage present at the active field distributor, if fed by the left FDC 157.

- **“L → R Current”**
  Required current in line and ring architecture, if fed by the left FDC 157. The required current includes the internal requirements of the active field distributor and the connected field devices.

- **“R → L Voltage”**
  Voltage present at the active field distributor in ring architecture, if fed by the right FDC 157. Lower voltage is applied to the left connector (internal consumption of the active field distributor and supply of the connected field devices) to continue the main line.

- **“R → L Current”**
  Required current in ring architecture, if fed by the right FDC 157. The required current comprises the internal requirements of the active field distributors and the connected field devices.

- **“Device Count”**
  Number of connected field devices which is used to check the total number of all field devices belonging to the segment/trunk. Higher or lower deviations are considered, i.e. the relevant field device will not be counted.

- **“Spur Count >1m”**
  Number of spur lines at the AFD which is used to calculate all spur lines of the segment/trunk and the maximum spur line length resulting thereof. AFDiS / AFDiSD spur lines will not be considered for calculation.

6. Consumers at the spur lines

The entered currents (current required by the field devices) are checked for compliance with the limit values. If a limit value is exceeded, an information field will be visible. Furthermore, the total of all currents is displayed beneath the input window.

The table below shows a list of currents as specified for the connectors of the active field distributors.

<table>
<thead>
<tr>
<th>Active field distributor</th>
<th>Connector</th>
<th>Current</th>
</tr>
</thead>
<tbody>
<tr>
<td>AFD4</td>
<td>S1 to S4</td>
<td>10 to 60 mA</td>
</tr>
<tr>
<td>AFD8</td>
<td>S1 to S8</td>
<td>10 to 60 mA</td>
</tr>
<tr>
<td>AFDiS / AFDiSD</td>
<td>S1</td>
<td>10 to 60 mA</td>
</tr>
<tr>
<td>AFDiS / AFDiSD</td>
<td>S2 to S6</td>
<td>10 to 40 mA</td>
</tr>
</tbody>
</table>

**NOTE**

For the current requirements of a specific field device, please refer to the associated data sheet.
7. Spur line lengths

The entered spur line lengths are checked with regard to their compliance with the specifications as listed in chapter 3.3 „Quantity framework, line length, current and voltage“. If the number of spur lines changes in the course of configuration, individual spur line lengths may become invalid. Example: If more than 15 spur lines are used, spur line lengths of more than 70 m become inadmissible.

Furthermore, the total of all line lengths is displayed beneath the input window.
5 Installation and Startup

SIMATIC Fieldbus Calculator

Unzip the SIMATIC Fieldbus Calculator and start it with a double click. Precondition for operation is that Microsoft .Net Framework 4.0 or higher is being installed.

NOTE

Startup

After startup, the product picture of the SIMATIC AFDiS is visible. You can create or open an existing configuration in the "File" menu.

NOTE
The default program language is set with the menu command "Edit > Language". The selected language becomes active after the program is restarted.
6 Operation of the application

Operation and functionality of the SIMATIC Fieldbus Calculator are explained by the example of two freely selected plant configurations.

NOTE

Based on the physical input data, the SIMATIC Fieldbus Calculator calculates the relevant electrical values and notifies about limit violations. Possible faults, e.g. incorrect wiring (grounding, potential isolation, etc.), address errors (double address allocation), communication errors (magnetic fields) and configuration errors will not be considered.

6.1 Scenario A – configuration with PROFIBUS PA

Scenario A describes the functionality and operation of the SIMATIC Fieldbus Calculator by the example of a configuration with two PROFIBUS PA line segments.

The figure below shows the plant configuration based on PROFIBUS PA.

Figure 6-1

The PROFIBUS PA segment is validated and verified as follows:
1. Calculation of the first PROFIBUS PA trunk (line architecture)
2. Calculation of the second PROFIBUS PA trunk (ring architecture)
3. Check of the number of all field devices belonging to the segment
1. Calculating the first PROFIBUS PA trunk

Table 6-1

<table>
<thead>
<tr>
<th>No.</th>
<th>Action</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Use the dropdown lists to select a field distributor type (AFD, AFDiS or AFDiSD) according to your configuration. Activate the checkbox right to the dropdown list to link the selected field distributor with the fieldbus trunk.</td>
<td>The arrangement of the active field distributors, in particular the AFDiS / AFDiSD, must comply with the existing or the planned structure. Deviations in arrangement will lead to different internal current consumptions of the AFDiS / AFDiSD, units.</td>
</tr>
<tr>
<td>2.</td>
<td>Enter the line length for the active field distributor. <strong>Note</strong> The line length to be entered refers to the section between the selected field distributor and the component placed to the left of it.</td>
<td></td>
</tr>
<tr>
<td>3.</td>
<td>Enter the currents of the consumers connected to the field distributor. Use the values specified in the data sheets of the corresponding field devices. <strong>Note</strong> The applicable number of connectors (I₁ to I₈) depends on the selected type of field distributor.</td>
<td></td>
</tr>
<tr>
<td>4.</td>
<td>Enter the lengths of the spur lines to the relevant field device. <strong>Note</strong> The cable resistance of this cable must match with that of the main line.</td>
<td></td>
</tr>
<tr>
<td>5.</td>
<td>Perform the above steps 1 to 4 for each further field distributor (including the subordinate field devices).</td>
<td></td>
</tr>
<tr>
<td>6.</td>
<td>Click the “Calculate” button to start calculation for the trunk.</td>
<td></td>
</tr>
</tbody>
</table>
Analysis

The calculations in the following table are described from top to bottom (from the field device to the segment/trunk).

Table 6-2

<table>
<thead>
<tr>
<th>No.</th>
<th>Action</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>The limit values (line lengths, currents and voltages) for the field distributors and the subordinate field devices have not been exceeded.</td>
<td>![Table 6-2 Image]</td>
</tr>
<tr>
<td>2.</td>
<td>The “Segment Calculation” area shows that all electrical values and the segment length are within the admissible limits. This means that no restrictions are expected during startup and operation of the segment/trunk.</td>
<td>![Table 6-2 Image]</td>
</tr>
</tbody>
</table>

2. Calculating the second PROFIBUS PA trunk

Table 6-3

<table>
<thead>
<tr>
<th>No.</th>
<th>Action</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Activate the checkbox for ring architecture and enter the line length for the redundant cable. <strong>Note</strong> Activation for ring architecture means that calculations for a coupler switchover (slave becomes active master) will be performed.</td>
<td>![Table 6-3 Image]</td>
</tr>
<tr>
<td>2.</td>
<td>Use the dropdown lists to select a field distributor type (AFD, AFDis or AFDisD) according to your configuration. Activate the checkbox right to the dropdown list to link the selected field distributor with the fieldbus trunk.</td>
<td>The arrangement of the active field distributors, in particular the AFDis / AFDisD, must comply with the existing or the planned structure. Deviations in arrangement will lead to different internal current consumptions of the AFDis / AFDisD units.</td>
</tr>
</tbody>
</table>
### 6 Operation of the application

<table>
<thead>
<tr>
<th>No.</th>
<th>Action</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.</td>
<td>Enter the line length for the activated field distributor.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The line length to be entered refers to the section between the selected field distributor and the component placed to the left of it.</td>
<td></td>
</tr>
<tr>
<td>4.</td>
<td>Enter the currents of the consumers connected to the field distributor.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Use the values specified in the data sheets of the corresponding field devices.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The applicable number of connectors (I₁ to I₈) depends on the selected type of field distributor.</td>
<td></td>
</tr>
<tr>
<td>5.</td>
<td>Enter the lengths of the spur lines to the relevant field device.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The cable resistance of this cable must match with that of the main line.</td>
<td></td>
</tr>
<tr>
<td>6.</td>
<td>Perform the above steps 2 to 5 for each further field distributor (including the subordinate field devices).</td>
<td></td>
</tr>
<tr>
<td>7.</td>
<td>Click the “Calculate” button to start calculation for the trunk.</td>
<td></td>
</tr>
</tbody>
</table>
Analysis

The calculations in the following table are described from top to bottom (from the field device to the segment/trunk).

Table 6-4

<table>
<thead>
<tr>
<th>No.</th>
<th>Action</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>The limit values (line lengths, currents and voltages) for the field distributors and the subordinate field devices have not been exceeded.</td>
<td></td>
</tr>
<tr>
<td>2.</td>
<td>The “Segment Calculation” area shows that all electrical values are within the admissible limits. This means that no restrictions are to be expected during startup and operation of the segment/trunk. The result of the “Loop Stability Check” shows that a corrected fault (e.g. cable break) at the segment/trunk hasn't been identified in time or time-delayed. Take note that the calculated value lies within the limit range. <strong>Consequential measures</strong>&lt;br&gt;&lt;ul&gt;&lt;li&gt;Relocating the field distributor including the subordinate field devices to a new segment&lt;/li&gt;&lt;li&gt;Moving of field devices at another field distributor&lt;/li&gt;&lt;li&gt;No further expansion&lt;/li&gt;&lt;li&gt;Reduction of consumers&lt;/li&gt;&lt;li&gt;Shorter line lengths&lt;/li&gt;&lt;/ul&gt;</td>
<td></td>
</tr>
</tbody>
</table>

3. Checking the total number of field devices included in the segment

The following table shows the summed-up number of all field devices of the segment and the corresponding data volume at minimum configuration (value and status).

Table 6-5

<table>
<thead>
<tr>
<th>Segment</th>
<th>Number of field devices</th>
<th>Data volume (5 bytes per device)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st trunk</td>
<td>7</td>
<td>35 bytes</td>
</tr>
<tr>
<td>2nd trunk</td>
<td>12</td>
<td>60 bytes</td>
</tr>
<tr>
<td>Total</td>
<td>19</td>
<td>95 bytes</td>
</tr>
</tbody>
</table>

The number of field devices in this example corresponds to a typical PROFIBUS PA application. A data volume of 95 bytes occupies approx. 40% of the maximum message frame length. This means that further data load can be configured.
6.2 Scenario B – configuration with FOUNDATION Fieldbus

Scenario A describes the functionality and operation of the SIMATIC Fieldbus Calculator by the example of a configuration with a FOUNDATION Fieldbus H1 segment.

The figure below shows the plant configuration based on FOUNDATION Fieldbus H1.

Figure 6-2

Calculating the segment

Table 6-6

<table>
<thead>
<tr>
<th>No.</th>
<th>Action</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Activate the checkbox for ring architecture and enter the line length for the redundant cable. <strong>Note</strong> Activation for ring architecture means that calculations for a coupler switchover (slave becomes active master) will be performed.</td>
<td></td>
</tr>
<tr>
<td>2.</td>
<td>Use the dropdown lists to select a field distributor type (AFD, AFDiS or AFDiSD) according to your configuration. Activate the check box right to the dropdown list to link the selected field distributor with the fieldbus trunk. The arrangement of the active field distributors, in particular the AFDiS / AFDiSD, must comply with the existing or the planned structure. Deviations in arrangement will lead to different internal current consumptions of the AFDiS / AFDiSD units.</td>
<td></td>
</tr>
<tr>
<td>3.</td>
<td>Enter the line length for the activated field distributor. <strong>Note</strong> The line length to be entered refers to the section between the selected field distributor and the component placed to the left of it.</td>
<td></td>
</tr>
</tbody>
</table>
6 Operation of the application

<table>
<thead>
<tr>
<th>No.</th>
<th>Action</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.</td>
<td>Enter the currents of the consumers connected to the field distributor. Use the values specified in the data sheets of the corresponding field devices. <strong>Note</strong> The applicable number of connectors (I₁ to I₈) depends on the selected type of field distributor.</td>
<td><img src="image" alt="Spur Currents" /></td>
</tr>
<tr>
<td>5.</td>
<td>Enter the lengths of the spur lines to the relevant field device. <strong>Note</strong> The cable resistance of this cable must match with that of the main line.</td>
<td><img src="image" alt="Spur Lengths" /></td>
</tr>
<tr>
<td>6.</td>
<td>Perform the above steps 2 to 5 for each further field distributor (including the subordinate field devices).</td>
<td><img src="image" alt="Overall Result" /></td>
</tr>
<tr>
<td>7.</td>
<td>Click the “Calculate” button to start calculation for the segment. <strong>Note</strong> You receive the message “The configuration contains invalid data!”. Please proceed the calculation.</td>
<td><img src="image" alt="Overall Result" /></td>
</tr>
</tbody>
</table>

**Analysis**

The calculations are considered and evaluated in the following table.

Table 6-7

<table>
<thead>
<tr>
<th>No.</th>
<th>Action</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Exceedance of the admissible spur line length is indicated in the input area for the line lengths <strong>Consequential measures</strong> Make sure not to exceed the spur line length of max. 120 m according to the list in chapter 3.3 “Quantity framework, line length, current and voltage”. In this example, the new spur line length is 100 m. <strong>Note</strong> The spur line lengths can possibly be shortened by changing the position of the field distributors.</td>
<td><img src="image" alt="Exceedance of the admissible spur line length" /></td>
</tr>
</tbody>
</table>
2. When combined, the number of field devices and line lengths results in a voltage value at the AFD (8) which is too low for energy supply from the left FDC 157. This may lead to:
   - unexpected communication errors with subordinate field devices.
   - physical disturbances or the FDC 157 switchover may be identified or performed too late.

The limitation that the startup voltages are insufficient has to also be taken into account during startup of the line.

**Consequential measures**
Reduce the number of consumers (recommended: max. 9 field devices). e.g. by relocating the AFDiS field distributor including the subordinate field devices to a new segment. In this configuration, this measure will have the largest effect.

3. Relocation of the AFDiSD field distributor (AFD (3)), including the three subordinate field devices and increasing the length (400m) between the field distributors, ensures stable operating conditions for the segment.

4. The “Segment Calculation” area shows that all electrical values and the segment length are within the admissible limits. This means that no restrictions are to be expected during startup and operation of the segment.
7 Further notes, tips and tricks, etc.

The individual functions described below simplify the use of the calculation tool.

Drag-and-drop functionality

If there are nearly identical configurations for multiple active field distributors, an active field distributor is configured and this configuration is transferred by dragging it to other active field distributors.

Configuration export

You can use the menu command "File > Save as picture..." to save the displayed configuration as a picture in PNG format. You can use this function to distribute the various configurations, e.g. also for display on mobile devices.
8 Related literature & links

8.1 Literature

Table 8-1

<table>
<thead>
<tr>
<th>Topic</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>/1/ Profibus PA</td>
<td>Instrumentierungstechnologie für die Verfahrenstechnik [~ Instrumentation technology for the process industry] Hans Berger Publicis Oldenbourg Industrieverlag ISBN 3835630563</td>
</tr>
<tr>
<td>/3/ Industrial communication</td>
<td>Catching the Process Fieldbus - An Introduction to PROFIBUS for Process Automation Publisher: Siemens Milltronics ISBN 978-0978249519</td>
</tr>
</tbody>
</table>

8.2 Internet links

Table 8-2

<table>
<thead>
<tr>
<th>Topic</th>
<th>Title / Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>/1/ Siemens Industry Online Support</td>
<td><a href="http://support.industry.siemens.com">http://support.industry.siemens.com</a></td>
</tr>
<tr>
<td>/2/ Download page of this entry</td>
<td><a href="https://support.industry.siemens.com/cs/ww/en/view/53842953">https://support.industry.siemens.com/cs/ww/en/view/53842953</a></td>
</tr>
<tr>
<td>/3/ How do you configure a ring redundancy with FDC 157-0 DP/PA couplers and active field distributors (AFDs)?</td>
<td><a href="https://support.industry.siemens.com/cs/ww/en/view/44887866">https://support.industry.siemens.com/cs/ww/en/view/44887866</a></td>
</tr>
<tr>
<td>/6/ SIMATIC Bus links DP/PA coupler, active field distributors, DP/PA Link and Y Link</td>
<td><a href="https://support.industry.siemens.com/cs/ww/en/view/11426966">https://support.industry.siemens.com/cs/ww/en/view/11426966</a></td>
</tr>
<tr>
<td>/7/ SIMATIC Bus links Amendments to the operating instructions for DP/PA coupler, active field distributors, DP/PA Link... 07/2011</td>
<td><a href="https://support.industry.siemens.com/cs/ww/en/view/105657140">https://support.industry.siemens.com/cs/ww/en/view/105657140</a></td>
</tr>
<tr>
<td>/8/ SIMATIC Bus links Active field distributor AFDiS</td>
<td><a href="https://support.industry.siemens.com/cs/ww/en/view/63033765">https://support.industry.siemens.com/cs/ww/en/view/63033765</a></td>
</tr>
</tbody>
</table>
## History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Modifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1.0</td>
<td>09/2012</td>
<td>First version</td>
</tr>
<tr>
<td>V1.1</td>
<td>02/2013</td>
<td>Support of the AFD with 8 short-circuit proof branch line connections</td>
</tr>
<tr>
<td>V2.0</td>
<td>11/2015</td>
<td>Support of new hardware Compact FF Link and AFDiSD. Calculation tool based on .NET Framework.</td>
</tr>
</tbody>
</table>

### Table 9-1

<table>
<thead>
<tr>
<th>Topic</th>
<th>Title / Link</th>
</tr>
</thead>
</table>